
W A T E R P R O O F  •  D E S I G N E D  F O R  S W I M M I N G !

128 Mb • Transmits Sound Utilizing Bone Transfer Technology • Lane 4¨ Goggles included
Enjoy your favorite music while swimming!

Water-Proof MP3 Player
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II. Custom Sound Units:
The SwiMP3 uses bone conduction, the 
direct transfer of sound vibrations from the 
cheek boneÊto the inner ear, to provide the 
swimmer with exceptional sound clarity.

I. SwiMP3 Player Module:
Store and control over 30 of your 
favorite songs in this waterproof, 
compact and comfortable device.

III. Lane 4¨ Goggle:
Lane 4 goggle integrates perfectly with the SwiMP3 Player. 
Standard goggles also work with SwiMP3 Player. 

VI. USB cable

1.	 Make sure your MP3 player is off and 
	 dry (not wet from swimming).  Plug 
	 round end of USB connector into the MP3 player.

2.	Plug the flat USB end of the connector into your computer's 
	 USB port (The USB port may be in the front or back of your computer).

CHARGING

1.	When the battery life is low, the green light will begin to flash. 
	 There may also be a noticeable difference in the music volume.

2.	Remember to dry the USB socket before charging.
     Open USB cap to dry internal components.

3.	To charge, simply plug it into the USB port on your computer as described above.
	 a.  When the MP3 player is plugged in, the red light will start blinking quickly; 
	 		 once the battery is full the blinking rate will slow down.
	 b.  The MP3 player will take two hours to fully 
	 		 charge, and will have approximately four hours 
	 		 of continuous play.
	 c.  Remember to properly disconnect your 
	 		 MP3 player as described in Step 4.

Once the USB cable 
is plugged in, a window 
may appear on your 
screen asking you
what to do.

When this window 
appears, select "Open 
folder to view files" and 
click OK. (If this window 
does not appear, simply 
go to "My Computer" 
and locate the MP3 
player listed as 
"Removable Disk" and 
double on click it.)

You should now be at 
the window shown to 
the left. The drive 
called "REMOVABLE 
DISK" is your SwiMP3 
player.

Drag songs to be 
added to your MP3 
player here.

To add songs, simply 
click on the song that 
you want to add and 
drag it into the 
"Removable Disk" 
window.

Once you have dragged the file 
over to the "Removable Disk" 
window, simply drop it.
A "Copying" window (below)
will appear showing you the 
progress of the file transfer.

Once the copying progress has 
finished, the window will close and 
you will be ready to listen to 
music on your MP3 player.

IV. Finis MP3
Carrying Case 

V. SwiMP3 Media Manager
Powered by MediaMonkey.
A smarter way to play, manage, 
discover and get music, burn
and rip CDs, create play lists
and load your SwiMP3.
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There are two options for adding songs to your SwiMP3;  a) utilizing the SwiMP3 Media Manager that must installed from the included CD,  or 
b) dragging and dropping files directly to your SwiMP3, which requires no installation.  For users who need to create MP3's, it is recommended 
to install the SwiMP3 Media Manager.  A step-by-step guide to create MP3's may be accessed from the Readme file located on the installation CD.  
For users who already have a MP3 collection, it is recommended to utilize the drag and drop method by following the steps below.

* Caution:
  Do not copy any file folders
  to the MP3 player.

To ensure songs play in the order you want:
a. Drag the songs to the SwiMP3 "Removable Disk" in the order you want them to play.
b. If you are using the SwiMP3 Media Manager, create a playlist of the songs you want on your
   SwiMP3 and organize them in the order you desire.  Next, copy all the songs to the SwiMP3
   in a single transfer.  Copy only the songs from the playlist and not the playlist itself.
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S A F E T Y

C U S T O M E R  C A R E

WARNING:  IT IS HIGHLY RECOMMENDED THAT 
YOU PROPERLY DISCONNECT YOUR MP3 
PLAYER BY FOLLOWING THE STEPS BELOW.

1.	Close the "Removable Disk" window 
where you just dragged your MP3's, then 
find the "Safely Remove Hardware" icon 
in the bottom right hand of your screen.

2.	Right click this icon and a menu will 
appear that says "Safely Remove 
Hardware," click this option.

3.	When the "Safely Remove Hardware" 
window appears, select "USB Mass Storage 
Device" and click the "Stop" button.

4.	The "Stop Hardware" window will 
appear.  Choose "Generic SND1 MP3 
Player USB Device" and click OK.  It is 
now safe to remove the MP3 player. 
(Your MP3 player may also start playing.)

Caution: Formatting your MP3 player will remove all songs from its memory.

1.	If your MP3 player ever stops functioning properly it may need to be formatted.

	 Reasons to format your MP3 player:
	 -You are having problems loading songs onto your player.
	 -The songs are jerky while playing or skip like a scratched compact disc.

      *The MP3 player uses the file system "FAT" only and not "FAT32"  
2. 	To Format your MP3 player.
	 a. 	Turn it on
	 b. 	Hold down PREV / VOL - then hold ON / OFF.
	 c. 	The green light will start blinking very quickly, then turn into a slow double 	
	 	 blink; this means the format is complete.
	 d.	Now you can reload your MP3's back onto the player.
   *Caution: If the green light does a triple blink when the MP3 player is turned on,
      press NEXT/VOL+ once .  The green light will blink rapidly then change to a  
      double blink; this means the memory has been initialized.  Now the MP3 player 
      is ready for song loading.

Resetting Your MP3 Player:

1.	When your MP3 player malfunctions, press the RESET button (white dot above 	
	 ON/OFF button) to reset your MP3 player.  All current files will remain as is.

1.	Position the SwiMP3 goggle comfortably over your 	
	 eyes and pull the SwiMP3 unit to the back of your head.

	 Secure the goggles by utilizing the adjustable straps 
	 on either side. Thread any excess strap back through 	
	 the slot in the earpiece.

2.	Position the SwiMP3 custom sound units on your
	 temple and cheek bone, between your ears and
	 eyes. (Do not position on your ears)

	 Turn on the SwiMP3 unit and adjust ear piece 	 	
	 positioning to optimize bone vibration sound clarity.

EXTRA FUNCTIONS:

1.	PAUSE
	 a. 	Press "Next" and "Previous" at the 
	 	 same time to pause the current song.
	 b. 	Press either buttons again to resume play.

2.	SHUFFLE
	 a. 	Press and hold "Next" and "Previous" at 	
	 	 the same time to randomize the order in 	
	 	 which your MP3s will play; release both 		
	 	 buttons when the red light starts to blink.
	 b. 	Turn off Shuffle by pressing and holding 		
	 	 "Next" and "Previous" until the red light 	
	 	 stops blinking.

3. 	BASS BOOST
	 a. 	Press the ON / OFF button once to 	 	
	 	 switch to and from "Bass Boost" mode

Only use attachments/accessories specified by 
the manufacturer.

Listening to music at full power over extended 
periods of time can be damaging to the hearing 
of the user.

The SwiMP3 player is safe to use in and around 
water. It is waterproof up to approximately 3 
meters or 10 feet and can be used safely in 
swimming pools, lakes, oceans or any body of 
fresh or salt water. It should not be used for 
any type of Scuba, free or skin diving and may 
malfunction or fail beyond its maximum depth 
of 3m/10ft.  All users of this product assume 
risks resulting from its use. Whether proximate 
or remote, there may be a risk of injury. 
Neither manufacturer nor seller of this 
product assumes any liability.

Any questions or issues regarding the SwiMp3, please direct 
inquires to the toll free number or email address below.

Customer Care Telephone and Email:

Tel: 800-388-7404
Email: customerservice@finisinc.com

S Y S T E M  R E Q U I R E M E N T S

ON / OFF
a.	ON - Press and hold for 2 seconds. Both lights will 	
	 come on;  when you release the button the green 
	 light will remain on.
b.	OFF - Press and hold until both lights 
	 come on, then release.

NEXT / VOL +
a.	NEXT TRACK - Press the button once.
b.	VOLUME (+) - Press and hold the button 	 	
	 until desired volume is reached.

PREV / VOL –
a. 	PREVIOUS TRACK - Press the button once.
b. 	VOLUME (-) - Press and hold the button 	 	
	 until desired volume is reached.

RESET
a. Press the small white dot above the 
	 ON/OFF button to reset your MP3 player.

System Requirements: Windows® 98SE, 2000, ME, XP
• Intel Pentium II 233 Mhz or equivalent • 128 MB RAM
• 35 MB available hard drive space • USB port • CD- ROM drive
• Internet connection recommended

Windows 98 Support: In order for the SwiMP3 to function with 
the Windows 98 Operating System, you must download the 
appropriate driver. Please utilize the enclosed CD within the 
SwiMP3 package or visit www.finisinc.com/drivers to access
and download the Win 98 driver.
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Creating MP3's from a CD
1. Open SwiMP3 Media Manager and insert a music CD into your computers CD-ROM drive.

2. Go to the "Tools" Menu and choose "Rip Audio CD."

3. A window will appear titled "Choose Encoding Destination.

	 a. Set the Format to MP3

	 b. You can choose where you want your MP3's to be saved by clicking the folder icon (default 	
	 location is C:\My Music).

	 c. Note: Your "My Documents" folder is listed under 
	 "C:\Documents and Settings\[user name]\My Documents" 
	 where [user name] is your Windows login name.

	 d. Once you have selected these two options you can click the OK button to begin encoding 	
	 your songs as MP3.  A bar will appear across the bottom of your Media Manager screen that 		
	 will show the encoding progress.

4. Once the encoding process is complete you can view the songs in your library by clicking any of 
the following icons listed under "Library."
	 a. Title
	 b. Artist
	 c. Album
	 d. Genre
	 e. Year 
	 f. Rating

5. Clicking any of these icons will allow you to view your library sorted by whichever icon you 
select.  Example: if you click Artist your library can be viewed with the songs sorted by artist name.

6. To add songs to your SwiMP3 simply drag a song from the library to the "Finis SwiMP3" icon.

7. You can view the songs which are on your SwiMP3 at any time clicking on the "Finis SwiMP3" 
icon.

8. Once you have loaded all desired songs to the SwiMP3 you can right-click on the "Finis SwiMP3" 
icon and choose "Safely remove device."

9. It is now safe to unplug your SwiMP3.



Importing Existing Files into The SwiMP3 Media Manager
1. Go to the "File" Menu and choose "Add/Rescan Tracks to the Library"

2. A window will appear titled "Add Folders."

3. Check the check box next to any folders which contain songs you wish to add to your Swimp3 
Media Manager Library.

4. Once you have selected the folders of music you wish to add to your library click OK.  A bar will 
appear across the bottom of your Media Manager screen that will show the progress.

Converting Non-MP3 Files into MP3 Format
1. Open The SwiMP3 Media Manager and select the track you wish to convert.

2. Go to the "Tools" Menu and choose "Convert Audio Format."

3. A window will appear titled "Choose Encoding Destination.

	 a. Set the Format to MP3

	 b. You can choose where you want your MP3's to be saved by clicking the folder icon (default 	
	 location is C:\My Music).

	 c. Note: Your "My Documents" folder is listed under 
	 "C:\Documents and Settings\[user name]\My Documents" 
	 where [user name] is your Windows login name.

	 d. Once you have selected these two options you can click the OK button to begin encoding 	
	 your songs as MP3.  A bar will appear across the bottom of your Media Manager screen that 		
	 will show the encoding progress.

4. Once the encoding process is complete you can view the songs in your library by clicking any of 
the following icons listed under "Library."
	 a. Title
	 b. Artist
	 c. Album
	 d. Genre
	 e. Year 
	 f. Rating

5. Clicking any of these icons will allow you to view your library sorted by whichever icon you 
select.  Example: if you click Artist your library can be viewed with the songs sorted by artist name.

6. To add songs to your SwiMP3 simply drag a song from the library to the "Finis SwiMP3" icon.

7. You can view the songs which are on your SwiMP3 at any time clicking on the "Finis SwiMP3" 
icon.

8. Once you have loaded all desired songs to the SwiMP3 you can right-click on the "Finis SwiMP3" 
icon and choose "Safely remove device."

9. It is now safe to unplug your SwiMP3.


